Fiche pratique informatique : passer de Microsoft Office a OpenOffice.org

Ce tutoriel fait partie d'un ensemble de fiches pratiques pour progresser vers la démocratie, et plus précisément du dossier
informatique http://www.ecologielibidinale.org/fr/fiches/miel-dossier-tic-fr.htm dans lequel vous pouvez trouvez d'autres
tutoriels pour OpenOffice.org (au § 3.1).

Version Web
Usage de OpenOffice.org
et différences d'avec Microsoft Office
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1 Introduction et installation

OpenOffice.org est une suite bureautique libre et gratuite qui assure les mémes fonctionnalités que la
suite Microsoft Office. Elle est développée par la société Sun et la communauté des programmeurs de
logiciels libres. Voir la présentation de Framasoft : http://www.framasoft.net/article472.html

Ainsi Writer se substitue a Word, Calc a Excel, Impress a Powerpoint, Base a Access, Draw a I'éditeur
graphique, et Math a I'éditeur d'équation intégré dans Microsoft Office.

OpenOffice.org peut lire les fichiers Microsoft Office, Star Office, RTF, TXT, HTML et XML.
OpenOffice.org peut enregistrer les fichiers aux formats Microsoft Office, Star Office, RTF, TXT,
PDF, HTML, XML et OpenDocument (format libre utilisé par défaut par OpenOffice.org).

OpenOffice.org est téléchargeable en version francaise sur le site http:/fr.openoffice.org

De plus des extensions pour le logiciel OpenOffice.org sont disponibles ici :

http://extensions.services.openoffice.org/

Nous vous recommandons d'installer au moins I'extension « espace insécable en frangais » qui ajoute
automatiquement un espace insécable avec les signes de ponctuation qui le nécessitent (! ? :; « »).
http://extensions.services.openoffice.org/project/insecable

2 Sources de documentation

Ce chapitre se base en premier lieu sur le livre écrit par Framasoft : Changer pour OpenOffice.org.

Le télécharger gratuitement (PDF) sur http://www.framabook.org/openoffice.html
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Remarque : le livre est basé sur la version 2.3 de OpenOffice.org. La version utilisée pour la
rédaction de ce document est OpenOffice.org 3.0. (Ainsi par exemple, depuis I'écriture du livre, la
numérotation des pages dans Writer est désormais mise a jour automatiquement.)

Ce document reprend du livre les €léments nécessaire a une utilisation bureautique basique. Pour le
transfert de documents Microsoft Office contenant des fonctions avancées (macros, publipostage,
formulaires, texte conditionnel...) se reporter directement au livre.

D'autre part le présent document compléte cet ouvrage concernant un certain nombre de
fonctionnalités usuelles, en s'appuyant sur la documentation (aide intégrée) de OpenOffice.org 3.0.

3 Opérations préliminaires

Paramétrer l'ouverture des documents au format Microsoft Office (.doc .xls .ppt) directement dans
OpenOffice.org (ceci peut se faire via l'explorateur Windows : Menu Outils > Options des dossiers >
Types de fichiers...).

OpenOftice.org peut étre réglé pour sauvegarder par défaut les fichiers au format Microsoft Office.
Cela n'est pas conseillé (risque de perdre certaines fonctionnalités). A utiliser seulement lorsque vous
avez besoin de partager les fichiers avec des utilisateurs n'utilisant pas encore OpenOffice.org. (Invitez
vos correspondant a changer...). Remarque : si vos correspondants n'ont pas besoin d'éditer le fichier que vous
envoyez (ex : note d'information), choisissez plutdt I'export au format PDF. Autre remarque : étant donné que beaucoup de
gens transmettent encore des fichiers propriétaires Microsoft Office, vous serez amené a les sensibiliser aux formats libres.

Voir un mod¢le de courriel de réponse a adresser, sur notre fiche pratique « passer a l'informatique libre ».

Conversion des documents : dés que l'on travaille sur un document au format Microsoft Office,
I'ouvrir dans OpenOffice.org puis apres vérification et éventuelles adaptations, 1'enregistrer au format
OpenOffice.org. Supprimer (ou archiver) ensuite la version Microsoft Office.

Remarque : il existe une possibilité de conversion de lots (batch) pour traiter automatiquement un grand nombre de
fichiers. Menu Fichier > Assistants > Convertisseur de documents... Toutefois cela ne permet pas de vérifier la qualité de

ce qui est obtenu. Les problémes les plus courants avec des documents simples sont de petites différences de pagination.

Avertissement sur les risques de régression : si vous faites des mises en formes ¢laborées, il est
possible que vous ne trouviez pas rapidement comment faire avec OpenOffice.org ce que vous faisiez
avec Microsoft Office. Vous pourriez alors étre tenté — surtout si votre temps est compté — de
reprendre votre document dans Microsoft Office.

Ce serait une trés mauvaise idée (expérience vécue !), en effet une fois repassé sous Microsoft Office
votre document pourrait perdre certaines mises en formes travaillées avec OpenOffice.org et vous
seriez obligé de refaire des ajustements. De plus procéder ainsi ne vous fera pas progresser dans
I'usage d'OpenOftice.org.

Voici notre conseil : si vous avez un peu de temps, utilisez I'aide de OpenOffice.org pour trouver
comment faire. Sinon renoncez temporairement a votre mise en forme complexe et revenez-y plus
tard.

Deés lors que vous serez habitu¢ a OpenOffice.org, nous vous conseillons de désinstaller Microsoft
Office de votre poste de travail. Remarque : il existe des « visionneuses » téléchargeables sur le site de Microsoft
qui permettent d'afficher les documents Microsoft Office qui ne seraient pas totalement pris en charge par OpenOffice.org

(cas notamment de certains effets complexes dans les présentations Powerpoint 2007).
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4 De Word a Writer

Il est possible d'importer dans Writer le dictionnaire créé dans Word, a l'aide d'un utilitaire a
télécharger. Voir le livre, chapitre 3, page 56 (p.70 du PDF).

4.1 Utilisation de modeéles
On peut convertir le modele Normal.dot de Microsoft Office en un mode¢le .ott
On peut stocker la configuration de Writer dans un mod¢le. Voir livre page 201 (p.215 du PDF).
Par défaut les modéles utilisateurs sont stockés dans :
C:\Documents and Settings\[User]\Application Data\OpenOffice.org\3\user\template\

Penser a les sauvegarder régulicrement. On peut spécifier un mod¢le par défaut pour chaque type de
document.

Attention : les modifications apportées au styles pendant 1'édition d'un document ne sont pas
répercutées dans le modéle. Si on veut les mettre dans le modele, il faut I'éditer directement : Menu
Fichier > Modéles > Editer... ou bien les transférer dans le modéle & partir du document actif en
utilisant la fenétre de gestion des modeles : Menu Fichier > Modeles > Gérer...

Voir aussi dans l'aide de OpenOftice.org les rubriques : « Modele de document » et « Changement de
modele par défaut ».

Pour afficher la fenétres des styles : raccourci <F11>. Au bas de la fenétre on peut choisir le type
d'affichage. Le premier élément de la liste : « hiérarchie » permet de gérer plus facilement les styles
car ceux-ci dépendent les uns des autres.

Vous pouvez télécharger notre modéle de démonstration (modele-openoffice-fr.ott) et I'adapter a vos
besoin.

4.2 Utilisation d'un document maitre
Menu Fichier > Nouveau > Document maitre.

Un document maitre rassemble plusieurs documents secondaires. On peut de plus ajouter du texte
directement dans le document maitre. La gestion des liaisons se fait avec le navigateur en mode
maitre.

4.3 Pages, sections et cadres

Microsoft Word n'utilise que les sections, et ces sections peuvent ou non étre associées a un saut de
page. Dans OpenOffice.org la facon de procéder est différente : ce qui releve de la page et ce qui
reléve de la section sont distingués.

Style de page: dans OpenOffice.org, chaque page peut avoir un style de page différent. Les
parametres de la page (marges, en-tétes et bas de page, etc.) sont associés au style de page. On peut
donc définir différentes mise en page au sein d'un méme document en utilisant ces styles (ex :
premiere page). Comme pour les autres styles (de paragraphe, de caracteres, de cadres, de listes) la
liste des style est accessible par le raccourcis <F11>. Pour changer de style de page, Menu Insertion >
Saut manuel... sélectionner « saut de page » puis choisir le style dans la liste déroulante (vous pouvez
aussi faire redémarrer la numérotation a un chiffre donné).
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Exemple d'application : changer l'en-téte et la numérotation des pages a partir d'un certain point - utile par

exemple pour des annexes.

Contrairement a Word, les parametres de mise en page pour le style courant sont accessibles dans le
Menu Format > Page... Ils s'appliquent a I'ensemble des pages ayant le méme style de page.

Les parameétres de section (ex: le nombre de colonnes) sont associés a une section donnée,
préalablement crée (contrairement & Word, il n'y a pas de section préexistante). Créer une section :

Menu Insérer > Section (éventuellement apres sélection du texte concerné).

Ci-dessous exemple de section (pour en modifier les propriétés : Menu Format > Section) :

Section a deux colonnes OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org

OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOftice.org OpenOffice.org OpenOffice.org
OpenOffice.org.

OpenOftice.org OpenOffice.org OpenOffice.org

Remarque : les sections (comme les paragraphes ou un bout de texte) peuvent étre masquées en
fonction d'une condition (la valeur d'une variable). Chercher dans 1'aide : « Masquage ».

Les cadres sont des objets contenant du texte. Ils se positionnent de la méme fagon que les autres
objets (tels que les images), c'est a dire par un ancrage. Créer un cadre :
(éventuellement aprées sélection du texte concerné).

Menu Insérer > Cadre

Exemple d'application illustré ci-dessous : numéroter les lignes seulement dans les cadres de texte :

Menu Outils > Numérotation des lignes... cocher « lignes dans les cadres texte » + Menu Format >
Styles et formatage > Modifier le style Standard > Onglet numérotation, décocher « compter les
lignes ». Pour les cadres a numéroter, utiliser un style non basé sur le style Standard (ici style
personnalisé¢ = a_citation-numligne).

Exemple de cadre texte avec numérotation des lignes (cliquer sur la bordure pour le sélectionner le
déplacer ou modifier ses propriétés via le menu contextuel) :

Cadre. La numérotation peut étre rendue indépendante du reste du document. OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org

OpenOffice.org OpenOffice.org OpenOftice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org.

OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org OpenOffice.org
OpenOffice.org OpenOffice.org.

Remarque : les cadres et les sections a plusieurs colonnes ne s'exportent pas correctement au format
HTML. Par ailleurs, dans ce format les éléments cachés de fagon conditionnelle sont tous affichés.
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4.4 Edition : différences entre Word et Writer

Les autocorrections peuvent étre paramétrées : Menu Outils > Autocorrections... Voir livre page 67
(p.81 du PDF).

Modes d'affichage : il n'existe pas de mode d'affichage « normal » dans Writer mais le mode « mise
en page Web » s'en rapproche. Le mode « mise en page d'impression » correspond au mode « page »
de Word. L'outil navigateur (raccourci <F5>) de OpenOffice.org se rapproche du mode d'affichage
« plan » de Word.

Nomenclature : dans Writer, les « signets » s'appellent « repéres de texte » et les « commentaires »
s'appellent « notes » (ne pas confondre avec les notes de bas de page).

Les en-tétes et pieds de pages restent toujours visibles dés lors qu'ils ont été activés. Ils ne se
positionnent pas a l'intérieur des marges, mais a l'intérieur de la zone de texte, contrairement a
Microsoft Office.

Espacement de paragraphes : lorsque deux paragraphes se suivent ils sont séparés par la hauteur
maximale de l'espace apres du premier et de l'espace avant du suivant. Contrairement a Microsoft
Office qui additionne les deux espacements.

Pour que l'insertion des espaces insécables en frangais soit automatique, il faut avoir installé
l'extension « espace insécable » a partir de http://extensions.services.openoffice.org/project/insecable

Insérer des guillemets doubles des deux types « exemple » (dans I'autocorrection il y a une option de
remplacement automatique) : Menu Insérer > Caracteres spéciaux > choisir ".

Idée : paramétrer un raccourci clavier pour cette insertion : Menu Outils > Personnaliser > Clavier :
pour OpenOffice.org associer <Ctrl>+<Shift>+3 avec Insérer/caractére spécial (puis Bouton
« Modifier »).

Exemple : "Texte entre guillemets".

Attention si on veut pas que l'autoformat les remplace plus tard, il faut décocher la case
correspondante de l'autocorrection : Menu Outils > Options d'AutoCorrection...Onglet Options >
Colonne [R] > Remplacer les paires d'apostrophes.
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5 De Excel a Calc

L'utilisation de modeles et de styles de pages s'applique a Calc de la méme fagon que nous l'avons vu
précédemment pour Writer.

5.1 Edition : différences entre Excel et Calc
Effacement du contenu d'une cellule :

* avec la touche <Suppr> : un menu avec des options apparait.

* avec la touche <Retour arriére <> : suppression avec options par défaut.
P Idée : utiliser <Suppr> pour effacer tout (c.a.d. formatage compris).

Recopie vers le bas ou la droite a I'aide de la poignée (coin inférieur droit de la cellule) : incrémente
les chiffres sauf si appui simultané sur la touche <Ctrl>.

Dessins utilisant des connecteurs :

Les fichiers Excel contenant des connecteurs sont correctement importés dans Calc. Toutefois, si 1'on
peut faire des dessins dans Calc, on ne peut y ajouter des connecteurs. Il faut pour cela utiliser
l'application OpenOftice.org Draw.

Si vous avez des connecteurs dans un fichier Calc, il vaut mieux copier le dessin (sélectionner tous les
¢léments) et le coller dans Draw pour pouvoir y modifier les connecteurs et en ajouter de nouveaux.

De maniére générale utilisez Draw plutot que Calc pour faire des dessins, organigrammes, etc.

6 De Powerpoint a Impress

Lors de la conversion de documents Powerpoint (extension ppt) en fichier Impress (extension odp),
vous pourrez observez quelques menues modifications :

» certains effets de transitions, non reconnus, seront remplacés par d'autres ;

* certaines polices de caractéres, si elles ne sont pas installées sur votre ordinateur, seront
remplacées par d'autres, ce qui peut entrainer certains décalages dans la mise en page du texte
des diapositives.

6.1 Pendant le diaporama

Le pointeur crayon, qui sert a souligner des éléments a 1'écran, n'est pas paramétrable dans Impress
(on ne peut changer son épaisseur - fine - ni sa couleur - verte). De plus il faut le sélectionner avant de
lancer le diaporama, a 1'aide du Menu Diaporama > Parameétres du diaporama...

Lors d'une présentation « chronométrée », le temps de lecture d'une diapositive s'affiche mais n'est
pas enregistré. Si vous souhaitez une présentation au déroulement automatique, il vous faudra
spécifier manuellement le temps de pose de vos diapositives.

Notes :

Ce document a été réalisé et exporté au format PDF directement sous OpenOffice.org Writer.
Les marques citées sont propriétés respectives de leurs auteurs.

Document sous licence Creative Commons by-sa http://creativecommons.org/licenses/by-sa/2.0/fr/
paternité=Association M.L.LE.L. - partage sous conditions identiques.
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